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Windows 7 Tip

Search the Internet from the 
Start Menu

The Start Menu's search box is a convenient way
to search through your PC -- but you can also
have it do double-duty and perform Internet
searches as well. To enable this feature:

1. In the Start Menu search box, type
GPEDIT.MSC and press Enter to run the Group
Policy Editor.

2. Go to User Configuration --> Administrative
Templates --> Start Menu and Taskbar.

3. Double-click "Add Search Internet link to Start
Menu," and from the screen that appears, select
Enabled. Then click OK and close the Group
Policy Editor.

4. From now on, when you type a search term in
the Search box on the Start Menu, a "Search the
Internet" link will appear. Click the link to launch
the search in your default browser with your
default search engine.
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DISCLAIMER

  As most of you know, the Alamo PC Organization has significantly reduced in size. Although the

organization has been pretty much dead for the past few months, there are a few key people that have been

working behind the scenes to try to resurrect and revive the group. Although it is a slow process, there has

been a lot of headway made. 

  For example, we are happy to be able to again offer our members a chance to download the award winning

PC Alamode magazine. Even though it is somewhat reduced in size, it is still packed with great articles and

tip and tricks for optimizing your PC's and just plain having fun. 

  Starting in the 1st quarter of 2011, we will again be having PC-based presentations at our monthly

meetings. Some will be live, while others will be "net" meetings. Regardless of the type, they will all prove to

be beneficial to the attendees. 

  So, as you can see, we want to continue the comradery of the user group, and want you back. W e are

presently charging no dues, and will try to continue this policy as long as we can. However, donations are

and will be greatly appreciated. 

  The rest of the website will remain up and accessible by all visitors, with the caveats below.

  Most of the information on the website is “dated” and the accuracy of the information cannot be

guaranteed. W ith these limitations in mind, we hope visitors to the website find what remains to be

somewhat informative and helpful. 

PC  Alamode (ISSN 1065-3708) is published on-line monthly by the Alamo PC Organization, Inc., PO Box

65180, San Antonio, TX 78265-5180, an independent association of personal computer users, founded in

January 1983, and incorporated in January 1984 as a 501(c)(3) non-prof it organization.

COPYRIGHT© 2011 by Alamo PC or the author. All rights reserved. No part of PC Alamode may be

reproduced or transmitted in any form or by any means  — mechanical, electrical, or otherwise — including,

but not limited to, photocopying, recording, or information storage/retrieval, without express written

permission from Alamo PC. However, unless otherwise indicated, articles may be reprinted by other user

and education groups provided the articles are reprinted unaltered and the publication acknowledges the

author thereof and PC Alamode. Articles, programs, reviews, and advertisements are compiled without

verification of accuracy or applicability to a specific task, computer, or other equipment. Comments or

claims are made solely by the individual author and do not necessarily represent the views of Alamo PC or

of any other Alamo PC member. Trademarks have been used at random within the publication and are

hereby recognized as such.
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The Running of the Nerds
By Lou Torraca, President 

The TUG MOAA Computer UG, Hawaii
www.the-tug.org

Af06hi (at) gmail.com

Finally! The much anticipated and always welcome last list from the 2011 CES running of the
nerds. A half-dozen goodies that caught my eye, made me stop and look and decide to add
to my growing list…no, I did not save the best for last…too trite to mention…just six I had not
used in my previous 2 lists…and, to satisfy a critic…my only one it seems, something for you
iPad devotees…really, u will love it!

Genesis
The new Genesis, just announced by
Lexmark, is about the coolest-looking
business device since the MacBook
Air. Even better, it’s powerful and
efficient. It’s also exceptionally simple
to use, and satisfyingly accessible
when it comes to more complicated
scanning and printing requirements,
like multiple images on one page.

In case you can’t tell from the photo,
what’s new about the Genesis is that
it stands vertically, as opposed to
horizontally as other printers do. So
when you want to copy or scan a
document, you lift the front of the
case forward and drop the paper in. 

Inside the machine is a 10-megapixel camera sensor which enables the machine to scan
much faster than most scanners and printers. Lexmark’s claim, borne out in our tests, is that
it transfers “from document to digital” in about three seconds – it’s not unusual to wait a
minute or more for this to occur with most printers. There’s no automatic page feeder, please
note, which is about the worst you can say about the Genesis.

If you’re familiar with scanning documents you’ll know the most time-consuming and deeply
frustrating part of the process is finding you’ve positioned the original in just-not-quite the
right place, and you only discover this when the scanning is finished.

Here, the camera sensor puts an image of what you’ll get onto the color display on the front
of the printer. So you know instantly if you’re in the right place and can adjust accordingly.
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Logitech Revue - This is for all u who want access to everything, everywhere!

It's TV that's all yours: With Logitech Revue, what you’re into is what’s on. Enter your favorite
actor and get what they’re doing on TV, the Web, Twitter and more. Watch the game and
your fantasy draft at the same time. Add the controller that fits your style. TV with lots of
possibilities means TV that you make your own.

Google TV in a box: Logitech Revue comes with an easy-to-set-up companion box and an
intuitive companion keyboard controller. Simply connect your TV and cable or satellite set-top
box via HDMI and your high speed Internet connection via Ethernet or Wi-Fi to the Logitech
Revue, and you’ve got Google TV.  

Future ready: Your TV can be the TV of the future, and it will only get better. Logitech Revue
is a companion to your TV and not a TV itself, so it can be easily updated. Plus Google TV is
an open platform, with developers creating more apps and functionality for release this year,
so your TV will do more as Google TV does more.

Built-in expandability: A growing selection of accessories means a growing Logitech Revue
experience. From video cameras that let you share your TV watching experience to a
smartphone app that gives you full control over your entire entertainment experience from
your phone, your Logitech Revue has room to do more.

Apps for your TV: With Logitech
Revue, you get apps created just
for your TV, including Netflix®,
NBA.TV and Pandora®. And with
apps for your TV available in the
Android™ Market later this year,
there’s no telling what your TV
will be able to do.

A compact keyboard, touchpad, and remote 

Not your average keyboard: The keyboard controller that’s included lets you find your shows,
surf the Web, or turn up the volume. By combining a compact keyboard, a touchpad, and a
remote in a sleek, living room-worthy design, Logitech Revue gives you full wireless control
over all your entertainment without leaving the couch.

Wired and wireless: To make sure your content is streaming as fast as possible, Logitech
Revue comes with your choice of Ethernet or fast 802.11 b/g/n Wi-Fi, so you can get
high-quality audio and video with whichever one works best for your setup.

Pocket eDGe is the world’s smallest dualbook-this is really neat. 7" tablet on one side, for
Android apps like web browsing, audio recording, and games.
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A 6" reader on the other side, for glare-free reading and stylus handwriting.
Beautifully connected. Seamlessly integrated. And more than twice as functional as a reader
or tablet alone.

Pocket eDGe
! Dimensions: 5.5" x 7.5" x 1.0" closed,11.0" x 7.5" x 0.5" open
! Weight: 1.35 lb
! Tablet screen: 7.0" WXGA (800x480)
! Tablet input: Resistive touch (use finger or
    stylus on screen), optical finger pad
! Reader screen: 6.0” e-Ink® (800x600), 16

shades of gray
! Reader input: Stylus (Wacom Penabled®)
! Operating system: Linux® with Google®

Android™
! Internal memory: 3GB
! Connectivity: Wi-Fi™ 802.11 b/g, Bluetooth®

capability, Ethernet-to-USB adapter available
! Screen Rotation: 90 and 180 degrees (tablet),

180 degrees (reader)
! Reader file formats: ePub, PDF
! Tablet video formats: 3GP, MP4, Adobe Flash Lite® (H.264), AVI (DivX or Xvid encoded),

MOV, WMV
! Tablet audio formats: MP3, WAV, 3GPP, MP4, AAC, OGG, M4A
! Keyboard: Virtual keyboard on tablet screen or connect your own by USB
! MicroSD card slot
! Standard USB port
! Mini-USB port with mini-USB-to-USB cable included
! Battery life: up to 6 hours, or up to 11 hours using only the reader screen
! Camera: 2 megapixel with video capability
! Built-in microphone
! Built-in stereo speakers
! 3.5mm headphone/headset jack (TRRS)

Aisle 411 is an easier way to shop…shoppers, man your carts…this one is for u!
 
Search: Just the way you want it in-store. Quick, simple and intuitive results
with one search. Each search lets you map it, add to list, share, or even edit
the location.

Offers: We'll inform you of deals you can find in-store; we call them
Informational Offers.  Some stores offer Digital coupons that you can "clip"
to your shopper loyalty card. Then scan your shopper loyalty, and get
savings off your bill.

Shopping Lists: Save a generic list, or manage lists by specific store. 
With aisle411, items are organized by aisle and section. You can also map
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your List(with stores that provide them) and use aisle411's unique interactive map to guide
you through the store while you shop. Or, share your list via SMS or email.

Reviews: Once you find what you're after, you can scan barcodes (iPhone app only) and get
product reviews served up from Amazon.com.  Even tap and speak the UPC number and
we'll pull review results if available.

Social Gaming: We think shopping should be fun, so with aisle411, you can earn virtual
rewards for not only a "check-in" at a store, but for "doing things" within aisle411.  Searching,
sharing, mapping a list, and even clipping some offers earn you points and badges.  Some of
the badges could unlock special offers from retailers and brands. There's even some
"hidden" rewards you can stumble upon as you search.  Then share your rewards with your
friends on social networks easily.

Available in select markets and retailers.

Just Mobile…here u go…if u have an iPad, u must have this! 

Wanna experience the stylish stylus for iPad? Just Mobile AluPen™
is a chunky pencil-shaped stylus with a soft rubber nib that sits
perfectly in the hand to make drawing and writing a uniquely smooth
experience.

  

Anti-Sleep Pilot - Break at the right time…depending on your driving routine, this may be an
absolute must to have.

Tiredness causes one in every five road traffic accidents: We all experience tiredness
occasionally when driving. The longer we drive the greater the risk of feeling tired as we
drive. Tiredness and driving are a lethal combination, responsible for around 20% of all road
traffic accidents.

Problem - We do not know when it is time to take a break:
Tiredness causes as many near misses and accidents on
the road as alcohol. But the big difference is that tiredness
is hard to gauge. With alcohol, motorists are not allowed to
drink more than a certain amount. But how do you assess
tiredness?

Break at the right time: Research has shown that regularly activating the driver and taking
breaks at the right time can prevent driving when tired. The Anti Sleep Pilot is a new Danish
product that calculates how tired you are, maintains your alertness and lets you know when it
is time to take a break.

This product aims at prevention. Unlike other solutions, the Anti Sleep Pilot is not designed to
wake you up once you have fallen asleep. If you fall asleep, reaction will often come too late.
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Instead, the Anti Sleep Pilot helps you avoid hazardous situations caused by tiredness. This
is why we say: break at the right time.

Anti Sleep Pilot adapts to you and your driving: The Anti Sleep Pilot adapts itself to you and
your driving. It can be used by anyone because it is customized for each individual driver and
driving situation. A single device will work for a variety of drivers and installs in all cars,
irrespective of make or model. It has been carefully designed so as to provide a subtle
interaction with the driver, avoiding unnecessary distraction.

Now, if u had a pilot I would know you would still be awake so I can tell you that’s it, have fun,
be careful and we will see u next time.

Aloha, Lou

You can read Lou’s monthly column at 

http://www.aroundhawaii.com/technology_in_plain_english.html / http://bit.ly/f3TQ5t

Cloud Computing Explained
By Sandy Berger, Compu-KISS

www.compukiss.com
sandy (at) compukiss.com

In our fast-moving world of technology, common words
sometimes take on new meanings. Apples and blackberries
used to be fruits, now they are also a type of computer and a
mobile phone. To back up used to mean "to go backward".
Now it means to "make a copy of your data." Gingerbread used

to be a tasty treat. Now it is also an Android operating system. A cloud used to be a fluffy
white mass that floats in the sky. Now everyone is talking about a different type of cloud.
 
You may have heard the terms "cloud computing", "cloud storage", and/or "cloud services".
In all of these, the cloud simply means the Internet, but the new terminology is indicative of a
big change that is already taking place.
 
Cloud applications are replacing desktop programs. That means that instead of having a
program running on your computer, you use a program or service that is on the Internet. Your
computer or your mobile device is simply the conduit that connects with your data and with a
program that accesses your data.
 
Many people are already taking advantage of these new cloud applications. Right now the
most widely used cloud applications are email programs. Using cloud-based services like
Gmail, Yahoo Mail, Hotmail, and AOL Mail is a popular thing to do. When you use a
web-based email program, you email is stored on Internet-connected servers that are run by
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the company that provides the service. So your Gmail account is hosted by Google. A Yahoo
Mail account is hosted by Yahoo! and a Hotmail account is kept on servers owned by
Microsoft.  With any of these services you can very easily access all of your email, including
old email that you have saved, from many different Internet-connected devices including
computers, cell phones, and tablets. You can easily access your email at work, see the same
email on your mobile phone on the way home, and then see exactly the same email on your
home computer.
 
If you are now thinking that perhaps you don't trust Google or Microsoft or AOL with your
email, just remember that even if you use an email program like Outlook or Windows Mail
that resides on your own computer, your email is still going through the servers of your
Internet Service Provider. So, in effect, with email you have to trust some company or
service.
 
Email alone has already propelled us into cloud computing. The email services mentioned
above are all free and they are all feature-laden, so millions of people have already taken
advantage of these services. In fact the move to email in the cloud is more of a tsunami than
a wave.  Google's Gmail service started in 2004. Wikipedia reports that as of November
2010, Gmail already had 193.3 million users monthly.
 
Other cloud applications are also becoming popular.
Google offers a whole set of free web-based applications
that rival Microsoft Office. With Google Docs you can
create and edit word-processing documents,
spreadsheets and presentations. These are like online
versions of Word, Excel, and PowerPoint. In some ways
they are even better because as with other cloud services,
your documents are available from any
Internet-connected computer. If you create a document at
work you can go home and see and change the same document. When you get to work in
the morning, your document has all the changes that you made at home. You can also give
another person or group of people access to your documents. This allows several people to
make changes to the same document -- great for collaborating on anything from a church
schedule to a complicated business proposal.
 
Millions of people also upload their photos to Picasa, Flickr, Shutterfly, Snapfish, the Kodak
Gallery, and other online photo services. This is a great example of cloud storage. It allows
you to have a copy of your photos online, to share them easily with family and friends, and to
show them off almost anywhere.
 
This week the move to cloud computing took an even bigger leap as Amazon unveiled a new
service called Cloud Drive. This service gives you 5GB of free online (think cloud) storage for
your music. This can be music that you purchase from Amazon or music that you upload
from your computer or your CDs.  Amazon then provides a small app called a CloudPlayer
that you can use to easily play your music on your computer and/or any Android cell phone
or tablet. This effectively means that you can play your own music just about anywhere. You
don't need a memory card. You don't need to move your music around.  You don't have to
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sync your portable device to your computer. Whenever you add new music, it is available
everywhere. This is cloud computing at its best.
 
Amazon is currently giving the first 5GB of storage for free and charging $20 a year for 20
GB. They currently also have some special deals for additional storage. You can also use
this storage for files other than music, as well. You can store documents, pictures, and
videos. You can access your files anytime from any Internet-connected computer and you
can download them to your computer if you like. Google and Apple are also said to be
working on similar services.
 
A few years ago, people questioned whether they would be willing to make the move to
online computing, online services, and online storage of their data. That question seems to
be answered. We are moving quickly to a ubiquitous Internet. Working in the cloud offers
conveniences that are very enticing. Almost all of the services we talked about here are free.
Pretty soon we will all be flying high  -- in the cloud!
 

Understanding System Restore
By Vinny La Bash, Regular Columnist

Sarasota PCUG, Florida
March 2011 issue, Sarasota PC Monitor

www.spcug.org / vlabash (at) comcast.net

Windows 7 has a new and improved version of System Restore that is far
superior to the lame utility that came with XP.  Setting a restore point was
often painfully slow, and it rarely worked as it should have. Windows 7 System
Restore easily helps you bring back your computer's system files to an earlier
point in time. It's a way to undo system changes to your computer without
affecting your personal files, such as e-mail, documents, or photos.  

Sometimes, the installation of a program or a driver can cause an unexpected
change to your computer or cause Windows to behave unpredictably. Usually, uninstalling
the program or driver corrects the problem. If uninstalling does not fix the problem, you can
try restoring your computer's system to an earlier date when everything worked correctly.

System Restore uses a feature called System Protection to regularly create and save restore
points on your computer. These restore points contain information about registry settings and
other system information that Windows uses. You can also create restore points manually.

System Restore is not intended for backing up personal files, so it cannot help you recover a
photograph or video that has been deleted or damaged. You should regularly back up your
personal files and important data using a backup program.  Windows 7 has an excellent
built-in backup utility.  
Windows 7 uses the Shadow Copy feature, introduced in Vista.  It's vastly superior to the
process in XP and earlier versions of Windows.  The old way used a simple file filter and

March/April 2011                                                                                                                             9



copied files around the system which was clumsy compared to the Shadow Copy method. 
Today, Windows creates a snapshot of your drive which can later be used to restore your
system should catastrophe occur.  

Additional capabilities of Shadow copy include taking snapshots of files even when currently
in use.  Microsoft has incorporated this feature into Previous Versions which allows restoring
a previous version of an application.  Unfortunately, this power is available only in Windows
Professional or Ultimate.   

The easiest way to bring up System Restore is to type System in the Start menu search box
and select it from the resulting list.  Another way is to select the Recovery option from Control
Panel, or you can simply type rstrui in the search box.  

Whatever method you choose will bring up the System Restore dialog box that gives you
some helpful information.  Select the Next button to get a list of restore points.  Most of the
time you will be using the most recent restore point to get your system working again.  

Focus your attention on the Description list.  This can give you an important indication of
what went wrong.  Did your problem begin after installing a Critical Update, a backup
operation, or a new freeware program that you couldn't resist?  

When you apply System Restore the system creates another restore point so you can undo
the change if your problem isn't fixed.  You can't undo System Restore however, if you use it
in safe mode.  But you can run System Restore again and select a different restore point.  

Restore points are saved until the disk space Windows allocates to the utility is used up. 
Then the oldest restore points are deleted as new ones are needed.  The easiest way to
delete all previous restore points is to turn System Restore off, and then turn it back on
again.  Don't worry about running out of space.  

Many computer problems can be traced to sloppy programs written by people who don't
know enough about proper programming techniques to get their utilities published by reliable
vendors.  It's surprising how many problems are generated by faulty uninstall tools.  There
are many sound freeware offerings out in cyberspace, but don't use them unless they come
tested and approved by a trusted source like Smart Computing.   :

A “Light Peak” at Thunderbolt
TechTip by Ryan Morse, March 13, 2011

www.geeks.com
Apple has been stealing recent headlines with two product line refreshes in the past few
weeks. The bigger of the two was probably the iPad 2, but it’s the I/O technology introduced
in the new MacBook Pro I’m interested in. Thunderbolt, a collaborative effort between Intel
and Apple, dubbed “the fastest connection to your PC experience,” is the newest high-speed
I/O protocol and in this TechTip we’re getting to know this interface and what it’s bringing to
the table.
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History

Intel announced Thunderbolt, which was codenamed Light Peak at the time, at
their Intel Developers Forum (IDF) in 2009 on a system that was displaying two
1080p HD video streams at once over optical cables (hence the “light” in Light
Peak), that used modified USB connectors. Intel intended it to replace the many
different cables, especially video cables, on the market and that it would be in
PCs by 2010. The cables were initially designed to bundle optical and copper
wiring together, pairing the speed of light with the electrical conductivity of

copper, to provide a low-latency, high-speed connection that provides power for devices.

What is it  
Thunderbolt combines the existing fundamental technologies of PCI Express
bandwidth and Mini DisplayPort connectors to provide two-channel 10 Gb/s
bandwidth upstream and downstream per port, double that of USB 3.0, over copper
wire cables with optical cables coming later. You will be able to daisy-chain up to
seven devices together, anything from high-resolution displays to cameras,
scanners, and data storage devices, all without a hub, because Thunderbolt
controllers will be able to transmit video and data signals are the same time over
the same cable. A “power-only” copper cable will carry up to 10 watts of power at up
to 3 meters and optical cables will be able to carry signals at what Intel says will be
“tens of meters.” If you scoffed at the previously-mentioned 10 Gb/s bandwidth,

Intel has already demonstrated 700 Mb/s on its
prototype hardware. Since Thunderbolt uses existing
technology, it’s designed to work seamlessly with your
operating system. A Thunderbolt device will work as either a
PCI Express or DisplayPort device on a non-Thunderbolt
system, which solves the problem of port-sharing. If you
accidentally plug a Thunderbolt device into a regular Mini
DisplayPort, it should work, provided the device isn’t relying on

power through that port. You can also use non-Thunderbolt devices in your daisy-chain by
adding them to the end of the chain. You can also use the wide variety of DisplayPort, DVI,
and VGA adapters so your older displays will work with it as well.

Impact
Since Thunderbolt is debuting on the MacBook Pro and will double as the system’s Mini
DisplayPort, it’s primary use is going to be connecting to high-
definition displays and HDTVs, but with its ability to handle
extremely high bandwidth transfers, it’s perfectly suited for carrying
high-definition audio as well, making it a viable competitor to both
HDMI and FireWire, as its functionality serves both of their
functions. Intel also claims that Thunderbolt is a complement to
USB 3.0, as opposed to being a replacement. It isn’t clear if Apple
is going to phase FireWire out of its products in the future, but Thunderbolt seems like a
logical step forward because it’s designed to accomplish the same thing and is twelve times
as fast, and its Mini DisplayPorts consume very little space.
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Conclusion
Thunderbolt essentially brings PCI Express connectivity out through Mini DisplayPorts, but
it’s not designed for every home user just yet. Instead, it’s aimed at the professional and
workstation market segment, especially those who are editing high-definition audio and
video. 

This may not have an immediate effect on the home user, but as it is said, “a rising tide lifts
all boats.”

Excel 2007 Tips
By Constance Brown, President, Canton/Alliance/Massillon UG, Ohio

March 2011 issue, The Memory Map
www.camug.apcug.org / president (at) camug.org

One of the first frustrations of moving to Excel 2007 or 2010 from an earlier version is
caused by the new xlsx extension that has replaced the xls extension that Excel spread-
sheets used for many years. This change does not allow users of earlier versions of Excel
to open the spreadsheets created in the new versions unless they have downloaded a
compatibility viewer. If you are using a new version of Excel and need to share a spread-
sheet with someone in an office that has not yet updated their version of Excel, you can
choose to save the new spreadsheet in an earlier format.

To do this, it is best to save the spreadsheet first of all in the
new format. Click on the Office button (2007) or File > Save
(2010) and Save as an Excel Workbook. Then save the
spreadsheet once again, using the drop-down menu to select
Save as Excel 97-2003 Workbook. At this point you have other
choices as well. Perhaps you wish to save it to be opened in the
free Open Office suite.

If so, select Open Document Spreadsheet. You can also
choose to have the file saved as a pdf which can be viewed,
though not manipulated, in Adobe Acrobat Reader or any number of other free pdf readers.

Have you ever wanted to copy a spreadsheet to another worksheet in the same or a new
workbook?

The slickest way to do so is to R click on the tab at the bottom of the worksheet and select
Move or Copy.  A window opens asking where you wish to move or copy the selected
sheets. If you wish to Copy, be sure to click on the box in front of the words Create a Copy. 
All your information PLUS formatting and formulas will be preserved.

By the way, you can rename tabs and assign colors to tabs by right clicking on them. And
you can drag tabs to change the order. You can also delete tabs by R Clicking and you can
also insert worksheets from other workbooks through choices offered through R clicking. To 

March/April 2011                                                                                                                             12



insert additional worksheets in the existing workbook, click on the icon with a starburst to the
right of your existing group of tabs.

Suppose you are looking at a spreadsheet that shows all the companies that have
purchased products from you and how much you have profited from the sales. You wish to
know what the average profit is, as well as the least and greatest amount of profit. And
certainly you want to know how much you total profit is. Did you know you can find out all
these answers and more without writing any formulas? First we will R click on the Status
Bar, an open area to the left of the zoom slider bar, and make sure that all the items we
want are checked. Next we will click on the column header above the column title of Profits
to highlight the entire Profits column. Voila! The Status Bar displays all the information we
wanted to see!

Now let’s suppose that we wish to
call attention to the profits that are
above average. We do this through
Conditional Formatting. With the
entire Profits column highlighted, we
will go to the Styles command group
on the Home tab. We will select
Top/Bottom Rules and then Above
Average and select the color scheme
we wish to apply to the cells displaying the above average profits. We can add icon
indicators as well. Freezing Panes offers a way to view column and/or row headers while
scrolling. Click on the tab titled View.  Click on a cell on a row below the header and then on
Freeze Panes / Freeze Top Row. To freeze both a row and a header, click on the cell
immediately to the right of the row you wish to freeze and below the header. 

That would often be cell B2. Then click on Freeze Panes / Freeze Panes.

Let’s look at one more way to examine our data. This time we will use filters. We access
filters from the tab titled View. You will see the filter under the command group titled Sort
and Filter. Click on the filter. Each column header will then display a button with a down
arrow. Suppose we are still working with our spreadsheet that shows profits from various
companies in the regions of the country where we sell products. We can go to the Regions
header and click on the down arrow of the filter and remove the checkmarks from all except
the West. Now we can look carefully at all the companies that have purchased from us in
the West. We can additionally filter on companies and or products to discover what
products and companies are most successful in the region we
have selected.

Excel is a powerful program with many user friendly tools hiding in the Ribbon. Don’t let the
new look of Excel intimidate you. There are many more powerful features and additional
ones that have been released in Excel 2010.

Go exploring and see what nuggets you can discover to share with others!
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File and Folders, and Now Libraries
By Phil Sorrentino, President, Sarasota PCUG, FL

Sarasota PC Monitor
www.spcug.org / president (at) spcug.org

Just when you thought you had it all mastered, something new comes along
to possibly change things. Well, it’s not really that bad, it’s actually pretty
good. Libraries are a new concept in organization that has been introduced in
Windows 7. You don’t have to use Libraries, but they are there to help you
organize and access your files. (Files being the entities that all programs
work with.) 

Windows 7 initially includes Libraries for Documents, Music, Pictures, and Video, the four
categories of information that many people use. You can create other libraries; you are not
limited to only Documents, Music, Pictures and Video. To create a new Library, Right-Click
"Libraries", and then select "New-Library", and give the New Library a name (much the
same way we create new Folders). 

As you can see below, initially each Library includes a "My" folder and a "Public" folder.
Windows 7 expects each user to organize his/her information into private and public folders.
The contents of the public folders are then shared with other users on your computer. New
Folders can be included in a library by using the Library Properties window. Right-click on
the Library you want to add a folder to, then select Properties, and then add a Folder to the
current list of "Library Locations" by clicking the "Include File Folder…" button, and then
naming, or navigating to, the Folder to be included in the Library. Folders can be removed
from a Library by Right-Clicking the folder to be deleted and selecting Delete.

A file, as you will remember from one of our
basic classes, is a collection of related
information. That information is organized in a
certain way and the applications that use that
"type" of file knows the organization scheme
and therefore how to use the information. The
file type is kept with the file name and is
actually the extension part of the file name,
(the letters after the period). For example, the
file "picture1.jpg" is a jpg type of file. (If you
don’t see the file extensions after the period
when using Windows Explorer, it is because
Windows is initially defaulted to not show the
extensions. To show the file extensions, Click
Start, then Click Control Panel, then
Double-Click the Folder Options icon, then
Click View, then Uncheck the "Hide extensions
for known file types" box, and finally, Click OK). 

There are many types of files. In fact, if you
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Google "file types" you will find websites that describe hundreds of different file types. The
"filext.com" website (and many others) has an alphabetical index to help you find a
particular file type. To review information about a particular file type, click on the first letter of
the file type of interest, then find the file type in the list and then click on that file type.
(Caution: To be safe, if you do go to this or any other site to see information about file types,
please do not click on any link you are not sure of, or any link that suggests a "scan" of your
system or your system’s registry or hard drive.) And while considering Files and folders, just
to be complete, Folders are collections of Files and/or other Folders. Folders are essentially
containers.

Now, Getting back to Libraries. Libraries are collections of folders. Libraries are a way of
collecting information (files) in order to keep related things together. The Pictures Library is
intended to keep track of all of your Pictures (jpg, jpeg, bmp, tiff, and other picture file types)
in one spot, therefore making it easier to work with your pictures. Similarly, the Documents
Library is intended to organize your documents (doc, docx, rtf, txt, and other text file types);
the Music Library is intended to corral your music files (mp3, wma, wav, m3u, and other
music file types); and the Video Library is intended to corral your Video files (mpeg, avi,
mov, vob, and other video file types). 

Libraries can also be created to organize information for a specific purpose, say a Movie
Maker Project. You could create a Library for a particular Movie, say the "OurWedding"
movie. You would create a Library called OurWedding and then you would include, in that
library, the working folders that you use while using your pictures, music and video
applications. (The actual folders remain with the application, but they are viewed as part of
the OurWedding library.) Then, when you create files using the various applications, all of
the files relating to OurWedding would show up in one specific place, the OurWedding
Library (a pretty neat trick, don’t you think?). This is pretty good because it leaves the
specific application to deal only with its specific type of file, and yet keeps all the project files
in one place for the project application. (For example you could use Windows Media Player
to Rip music from your CDs, Photoshop Elements to collect and finish the pictures of your
wedding, and Adobe Premier Elements to preview and cut the videos for the movie. When
all the Picture, Music, and Video files are done and in their folders, you could use Movie
Maker with the OurWedding library to put it all together into a Movie and burn it to a DVD.) 

Libraries provide a way of superimposing a structure or organization on what might look like
an unorganized collection of files and folders. Libraries are really just another tool to be
used to help us use our computers in a smart way. When you get Windows 7, give them a
try but don’t jump in too fast. First, organize your folders in a basic structure (the way you
might think of organizing a file cabinet) and then apply Libraries on top of that basic
organization, to your benefit. In time, I’m sure you’ll find Libraries helpful. 
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Access 2010 The Missing Manual
By George Harding, Treasurer, Tucson Computer Society, AZ

March 2011 issue, TCS eJournal
www.aztcs.org

georgehardingsbd (at) earthlink.net

The Missing Manual series now totals almost 60 books! The reason the series is so popular
is because software/hardware makers don't include the hefty manual they used to, but
buyers need more than the Quick Reference Guide that now replaces the manual that used
to be. It's published by O'Reilly - Pogue Press .

The book is written by Matthew MacDonald but there is
a team behind him that supports a colossal project such
as writing a book. All examples have to be tested by
actual example. The illustrations in the book, likewise,
have to be reproduced.

The book is pretty hefty, consisting of 812 pages, of
which 17 are the all-important index and one Appendix.
The book is divided into seven parts with 23 chapters,
each covering a broad topic.

The Introduction is, in contrast to some, very valuable. It
tells what's new in the 2010 version of Access and how
to use some of these features. One of the valuable
items is the "missing" CD-ROM. You can download it at
the web site. It has all the examples used in the book,

so you can see how to do any of them.

Access has four main parts: tables, queries, forms and reports. The latter three all 
depend on tables. 

Part One of the book deals with creating tables, accessing the data contained in them,
making sure the data is useful and valid, and relationships between tables. This 
is probably the most important section, because if the table isn't built correctly, the queries,
forms and reports may not work properly.

Part Two covers queries, including the basic select type, as well as update, append and
update types. Since many forms and reports use queries as the source for information,
learning how to create and use them is important. Frankly, though, creating select queries is
really easy and the other forms are not often useful.

Part Three deals with creating and printing reports. 

Part Four covers forms, including using a special type of form as a user interface. Simple
forms, though, are easy to create and are most useful for those who are not very familiar
with Access. 
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That covers the four basic tools in Access, but there's more. Access has built in an
extensive programming system and Part Five covers several aspects of it. These include
macros and Visual Basic. With these two tools, one can develop a database system that is
useful, but whose insides aren't visible to the user.

Part Six, the last one, covers new aspects of Access, namely, multi-user databases,
import/export, connecting Access to SQL Server and SharePoint, as well as building a web
database.

This is both a top-notch reference book and a helpful learning tool. I highly recommend it.

About:  Access 2010 The Missing Manual 
Author:  Matthew MacDonald
Vendor:  O'Reilly-Pogue Press
www.missingmanuals.com
ISBN-10:  1449382371
ISBN-13:  978-1449382377
Price:  $39.99, $24.55 @ Amazon

Free Comic Books Online
By Ira Wilsker, Member, Golden Triangle PC Club, TX

Columnist, The Examiner, Beaumont, TX
Radio Show Host, Mondays, 6-7pm CT, KLVI.com

iwilsker (at) sbcglobal.com

WEBSITES:
http://www.techsupportalert.com/free-books-comics
http://www.bbc.co.uk/cult/buffy/ecomics
http://borderwalker.com
http://www.comicweb.com/goldenage_comics.htm
https://read.dccomics.com/comixology/#/free_comics
http://digitalcomicmuseum.com

When I was a kid growing up in the 50's, I enjoyed buying and reading comic books.  While
most of them were a dime, some were expensive at a quarter.  My dad acquiesced and
when I with him to the drug store to buy funny comic books that he approved, such as Little
Lulu.  My mom gave in if I wanted to buy any of the classic comic books, which were
literature trans-formed into a comic book format.  Some of my elementary school teachers
decried comic books as the ruin of my generation, and confiscated them in wholesale
quantities from me and my classmates, probably to surreptitiously read in private and to
trade with the other teachers for their stash of contraband.  Today, with the internet, video
games, and other forms of entertainment, contemporary comic books are not as popular or
as widely available as in the past.  For present and former comic book aficionados, there
are now free online resources that allow some of us to relive our long lost juvenile days, and
to also allow today's generations to experience the joys that I enjoyed decades ago.
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One of the top free software information websites, Gizmo's Freeware (techsupportalert.com)
recently published a directory and reviews of the top free online comic book repositories

(techsupportalert.com/free-books-comics).  Gizmo made it a
point that the listed sites were not pirate websites displaying
illicit copies of copyrighted content, but instead were totally
legitimate websites with totally legal content.

The first listed site that I visited displayed the first issue of
Action Comics, dated June, 1938, which is the issue that
introduced Superman to the world.  According to Gizmo, a
copy of this issue sold recently for $1.5 million, but anyone can
view it online for free.

One of my adult daughters is a fan of the TV version of "Buffy
the Vampire Slayer", and would probably find the 11
"e-comics" posted online by the BBC most interesting
(bbc.co.uk/cult/buffy/ecomics).  BBC has also posted several
of the "Dr. Who" comic series online at

www.bbc.co.uk/doctorwho/s4/misc/fiction/writerscomics for those who like the popular TV
show of the same name.

"The Comic Web" at www.comicweb.com/goldenage_comics.htm has over 30 full-length
comics from 1936 to 1955 that can be viewed online for free, and downloaded as a PDF for
only a dime.  Captain Marvel #1 " Captain Marvel Battles the Vampire" from 1941 started a
cult classic, and can be viewed online at
www.comicweb.com/onlinecomics/captain_marvel_01_story.pdf.  Other Comic Web
holdings include a few of the World War II series of super hero comics "Fighting Yank"

where the super hero, wearing a cloak and
tri-corner hat reminiscent of 1776 takes on the
axis powers.  On the bottom of each "Fighting
Yank" page is a patriotic statement of the day,
encouraging the reader to buy war bonds or to
contribute to the scrap drives to defeat the
axis.  Considering the date of publication and
the then contemporary events in the news, it is
obvious how the "Fighting Yank" would appeal
to the children of the day.  One of the oldest
comics on the Comic Web page is "Detective
Picture Stories #1 - Bogus Bills" from 1936. 
"GI Joe #10" from 1950, reflects some of the
sentiments from early in the Korean War,
where the U.S. soldiers have to deal with the
likes of an attractive female reporter while
dealing with a "Russky tank".  While patriotism
is a common theme of many comics of the
period, what may be the epitome of a patriot
super hero may be the 1941 rendition of "The
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Flag" who is the adopted son of a crippled war hero, and has the speed of the wind, and the
strength of a hundred men.  In his red, white, and blue uniform he takes on the enemies of
America.  In Our Flag #3, The Flag removes a flag bearing the swastika from the dome of
the capitol building, and defeats the enemy who has torn down the American flag from the
Capitol building; in just16 pages, The Flag saves the country.  While not as dramatic, in the
1941 comic book "Stars and Stripes #4" another super hero, the Iron Skull, saves a convoy
of ships from marauding U-Boats.  While historically inaccurate, comics like these can be
used to demonstrate some of the popular ideas and philosophies of the day, and show how
those contemporary super heroes dealt with the pressing issues facing the country.

DC Comics, one of today's predominate comic book publishers, has been publishing comic
books since 1934.  In addition to producing print comic books, DC Comics has made
available a large collection of free comics online at
read.dccomics.com/comixology/#/free_comics.  With new titles added frequently, DC
Comics has an impressive collections of comic books available.  In Superman Confidential
#1 (January 2007), the secrets of Kryptonite are explained; for those who may be unaware
of the Superman saga, Kryptonite is a strange mineral from the defunct planet Krypton, that
has the unique power of sapping Superman's legendary strength, depriving him of his super
powers.  In a two-page teaser to encourage the reader to purchase the full comic, DC
Comics online has "The Origin of Robin", the super hero that becomes the famous sidekick
of Batman.  Other super hero comics included on the free DC Comics website, consisting of
either teasers or full editions, are the likes of Justice League of America, Wonder Woman,
and the Green Lantern.

One of the largest libraries of online comic books is the Digital Comic Museum
(digitalcomicmuseum.com) which has
over 6000 comic books available for
free download (free registration
required).  On this website I found
many of the comics that I enjoyed as a
child.  The date ranges of the comics at
the Digital Comic Museum are from
1902 to 1986.  Some of the larger
collections sorted by publisher on this site include Charlton Comics with 650 issues;
American Comics group (493); Better/Nedor/Standard/Pines Publications (410); Comics
House Publications (445); Dell Comics (517); Quality Comics (1243); and Fawcett Comics
(1120 issues).  Many old classics are available, including such oldies as The Katzenjammer
Kids and Little Orphan Annie.  There is even a comic book available that was published and
distributed by the U.S. Government, "Burt the Turtle Says Duck and Cover"; we were
provided a copy of this exact comic book in elementary school where it was mandatory that
we read it in class, and then practiced our "Duck and Cover" drills that were supposed to
protect us from a Soviet nuclear missile strike.  The user should be aware that many of the
comic books available for free download from this website are compressed with a variety of
compression methods, so that a free universal decompression utility such as PeaZip
(peazip.org), or 7-Zip (7-zip.org) may be necessary to prepare the files for viewing.
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There are many other websites listed by Gizmo that have free comic books to view and
download.  With free resources such as these, it is easy for some of us to relive our
childhood, while others may discover a forgotten but very entertaining resource.

Ira Wilsker is a member of the Golden Triangle PC Club as well as Director of the
Management Development Program at Lamar Institute of Technology, in Beaumont, TX. He
also hosts a weekly radio talk show on computer topics on KLVI News Talk AM560, and
writes a weekly technology column for the Examiner newspaper <www.theexaminer.com>.
Ira is also a police officer who specializes in cybercrime, and has lectured internationally in
computer crime and security.

7 Little Word Annoyances and Their Easy Fixes
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL

March 2011 issue, Sarasota PC Monitor
www.spcug.org / ndemarte (at) verizon.net

 
Below is a collection of frustrating things that can happen when using Microsoft Word.
These annoyances can occur in any version of Word although most are geared to Word
2007 and 2010. In Word 2003, the fix-it steps may be different.

Annoyance 1 -- You accidentally press the Caps Lock key on your keyboard before typing
a paragraph. When you finish, you find everything in capital letters.

The Fix: Rather than retyping the whole paragraph, highlight the text, then click the
"Change Case" button (Aa), located on the Home tab in the Font group. Click "Sentence
case" to transform your paragraph into normal sentences. 

Annoyance 2 -- You create a party invitation with a light blue background (Page Layout tab
- Page Color). But when you print it, the background is white.

The Fix: Office has set Word to not print full page background colors, probably to save
users from wasting ink. You can, however, make the colored background print. Click the
Office button, then Word Options -- Display. Put a check mark next to "Print background
colors and images," then click OK. Until you remove this checkmark, all colored
backgrounds will print.

Annoyance 3 -- You're working on a document where you've set the text size to be a fairly
small 10 points. But you find that the text is too small to view comfortably while you're
typing.

The Fix: Drag the Zoom slider located in the bottom right corner of the Word window to the
right to enlarge the screen view of the text. When printed, the text will be 10 points no
matter how big it appears on the screen. 
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Annoyance 4 -- You find that the spaces between lines of text in your document are wider
than you want.
 
The Fix: If all the spaces are wider than expected, you can change the line spacing for the
whole document at once. On the Home tab, in the Editing group, click Select -- All to
highlight all the text. Next click the Line Spacing button in the Paragraph group and select
1.0 for single-spacing or one of the other choices.

Note: Word will not remove extra space after paragraphs when you choose a line spacing
size. To remove extra space after a paragraph, select the paragraph before the extra space,
click the Line Spacing button and choose "Remove Space After Paragraph." A more
permanent way to create no extra space between paragraphs is to open the Paragraph
group dialog box launcher (small diagonal arrow) on the Home tab and put a checkmark in
front of "Don't add space between paragraphs of the same style."

Annoyance 5 -- Every time you type an email or web address into a document, it turns into
a clickable hyperlink with underlined blue text, even if that isn't your intention.

The Fix: The quickest fix is to right click the address and select "Remove Hyperlink." But
this is only a one time remedy. To remove this action permanently, click the Windows
button, then this sequence: Word Options -- Proofing -- AutoCorrect Options -- AutoFormat
As You Type. Remove the checkmark next to "Internet and Network paths with hyperlinks"
and click OK.

Annoyance 6 -- You find that as you type, distracting wavy red and green lines show up
under words and phrases. 

The Fix: Word is set to check spelling (red lines) and grammar (green lines) as you type.
This is another Proofing option which comes enabled from the factory. To turn off one or
both of these features, go to Word Options (Office button - Word Options) and click
Proofing. Remove the checkmarks next to "Mark grammar errors as you type" and "Check
spelling as you type." You can always check spelling and grammar after your document is
complete by clicking Spelling & Grammar at the left end of the Review tab.

Several of these fixes involve the settings found in the Options area of the Office 2007
menu (File menu in 2010). Options are available for all the Office programs (Word Options,
Excel Options, Access Options, etc.) These default settings were determined by interviews
with thousands of people who use Office regularly in the workplace. If you find that the
factory settings are causing you more trouble than help, changing them is a simple task. All
Office users should take a personal tour of the Options menus, which resemble this Word
Options window with the AutoCorrect box open:
 
Annoyance 7 -- You often save documents to the same folder which is buried within other
folders in My Documents. It takes several clicks to find this folder each time you want to
open or save a document to it.
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Fix 1: You can find almost any folder on your Windows Vista or 7 computer by typing its
name into the Start Menu search box just above the Start button. Often it takes only a letter
or two before the folder appears in the search results. On the downside, you have to do this
each time you want to open the folder.

Fix 2: A way to make any folder immediately available is to add it to the Favorites section of
the navigation pane. This pane appears on the left side of any explorer window where you
are viewing, opening or saving files and folders. To make a folder a Favorite, start by
creating or opening a file, like a document, and click Save As, which opens the Save As
dialog box. This reveals the navigation pane on the left, showing a list of possible places to
save the file. Navigate to the folder you want to make a favorite so that it is the last item in
the history bar across the top. Then right click the word Favorites in the left pane. From the
drop down menu, click "Add current location to Favorites." Your special folder will now
appear in the Favorites list. It will also appear in the Favorites list of the other MS Office
programs on your computer, such as Excel and PowerPoint. To remove a folder from
Favorites, right click the folder and select Remove.

Using a computer should be fun as well as useful. Take a few minutes to think what your
personal computer annoyances are and try to find fixes for them. Customizing your
programs makes using the computer much more enjoyable and efficient.

            The Lighter Side   

Bucky Milam is a master of the fine
arts, with an emphasis on the cool and
casual. He is the recipient of numerous
awards for his painting and graphic
design, which has been displayed at
the Dallas Museum of Fine Arts, the
Museum of Modern  Art, the Chicago
Art Institute, and the London and Tokyo
Museums of Fine Art. A trumpet
virtuoso, he performs widely in clubs
throughout the region and is a
recognized composer of jazz and
classical music for brass.
Bucky comes to computing as an
accidental tourist. His peculiar
perspective is of the visual media and
the image they project of our civilization
and culture. You can find his musings
in each monthly issue of dacs.doc. (Danbury Area Computer Society)
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Smart Computing Tips
www.smartcomputing.com

Find Your Devices
To find out what components are in your computer, right-click the My Computer icon on the
desktop. Click Properties, then click the General tab. This tells you what OS you are using,
the processor speed, and amount of RAM in the computer. To view the actual devices, click
the Hardware tab and then click the Device Manager. In the Device Manager you will see a
list of every type of hardware in your computer. For example, if you click DVD/CD-ROM
drives you will see each separate drive listed under that category. To see more information
about any specific drive double-click it. This lets you see component info, such as the
device status and if the device is enabled. You will also see what drivers the device is using
and when they were last updated. 
 

Animate Menus
You can animate the drop-down menus for FrontPage, Word, and Access. To do this,
right-click any visible toolbar and then choose Customize from the shortcut menu. In the
Customize dialog box, click the Options tab. Click the Menu Animations drop-down arrow
and then choose an effect (such as Slide or Unfold) from the list. Click Close to confirm your
choice and use the menu animations. 

Quickly Enter A URL In IE
When you manually enter a URL in Internet Explorer, it can be a hassle to use your mouse
to select the address bar, highlight the URL, and delete the current Web address. To
expedite the process, press F6 on your keyboard and your cursor will automatically move to
and highlight the current URL in the IE address bar. Because highlighted text is
automatically deleted if other text is entered, you can simply type your new URL in the IE
address bar. 
 

Speedy SD Cards
The current storage capacity of memory cards allows you to store a number of MP3s and
video files for playback on your mobile phone. But if you’re planning on streaming the media
or copying a large amount of files on and off the card, you’ll want to invest in a fast SD card.
SD cards are available in a Class 2, Class 4, or Class 6 transfer speed ratings, and the
higher the number, the faster the card can read and write data. Rather than a maximum
speed, the speed rating represents the minimum transfer speed the card will maintain, so
you’re assured that card won’t fail below a given performance level. 
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Updates! Updates! Updates!
By Penny Cano, Member and Instructor for the

Dumb & Dumber Workshops, Cajun Clickers Computer Club, LA
March 2011 issue, Cajun Clickers Computer News

www.clickers.org / ccnewsletter (at) cox.net

"Something popped up on my computer saying I needed an update. I
didn't know if it was OK, so I didn't do it." Does this sound familiar?
Updates are one of the most important things you can do for your
computer. So what needs updating? The answer is almost all the
software on your computer. Updates patch security holes that allow
access to your computer from outside and correct defects in software
programs.

First and foremost is Windows itself. Patches fix security vulnerabilities
and program flaws in the Operating System. Most people choose Automatic Updates, which
downloads and installs these "fixes" for Windows without them having to worry about it. But
Windows is not the only Microsoft program that needs updating. An option you can choose
in Microsoft Update allows it to also take care of Microsoft Office suite, Microsoft Works,
Windows Live, Silverlight, and a whole host of other Microsoft products installed on your
computer that also need updating.

Of equal importance are updates for your Virus/Spyware program or Internet Security suite. 

Don't know which one you're using? It's time you found out!! Double click on the icon in the
lower right hand corner of the screen and when the program opens look for the date of the
latest definition/update. It should be no later than yesterday. The virus program can only
remove the "bad stuff" if it can recognize it, and it gets those descriptions in the definitions
downloaded from the Internet.

Now what else needs updating? Java, Flashplayer, and Shockwave are three programs that
deal with animation on websites. Adobe Reader occasionally has newer versions, but there
are updates for the older versions if you prefer to keep them instead of upgrading. Do you
have RealPlayer, Quick Time, or iTunes on your computer? Yes, they need updating too.
Alternative browsers like Firefox, Chrome, and Safari are on the list. Add e-mail programs
like Mozilla Thunderbird and Incredimail. Printer software, Support software from your
computer manufacturer like HP Advisor and Dell Support Center, graphics programs like
Photoshop….the list is endless.

So how do you determine which update requests to allow? One way is to open the Control
Panel and choose "Add Remove Programs" in XP or "Programs and Features" in Vista and
Windows 7. Become familiar with the list of programs installed on the computer. (If you can't
remember all of them, at least you have a preference.) If one of these programs requests
an update (a popup or notification in the lower right hand corner of the screen), the answer
is "Yes, thank you for keeping me current."
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Some of the programs aren't so accommodating. Many can be manually updated by
choosing "Check for Updates" under "Help" on the program's menu. There may also be a
choice under "Options" (Settings, Properties, or some such wording) to automate the
process.

There is a website that can help you decide. Http://secunia.com has an online scanner  (use
"Scan now" in the upper right corner, "Start Scanner" on the next page, and check "Enable
thorough system inspection" on the next page before you hit "Start") that will look at your
system and list insecure programs. You can also download Secunia Personal Software
Inspector (PSI) free for home users.

http://filehippo.com is a source for many of the freeware and shareware programs we use
(Adobe Reader, iTunes, Firefox, Open Office, AVG Antivirus, etc). You can download their
free Update Checker which will also help keep you up to date with the latest versions of that
type of software.

 
 

A Free Apple a Day Keeps the Doctor Away
By Larry Anders, Member, Tampa PCUG, Florida

www.tpcug.org / larry (at) anders.net

I had been highly opposed to Apple products for years because of what I feel to be the
small-mindedness of Steve Jobs and the Apple management by not making their code
available to developers, which would allow software to be developed so there would be
more choice at reasonable prices. If so, I'm sure there would be a Mac in my house instead
of just seven PCs running various Windows operating systems.

Above, you'll notice I said "had" been. Then I purchased my first iPod,
and I was hooked! I did not get the first version iPhone, but I have had
the 3GS now for almost two years. It is about the 10th cell phone I've
owned and by far the very best. I have been tempted to try an Android
phone but so far have had no reason to give up the iPhone. The Apps
for the iPhone make it an everyday challenge to find something useful,
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and typically for free. Why Mr. Jobs can't see that allowing all these
people to develop software for the iPod/iPhone/iPad has made his
products extremely successful is beyond my understanding. He has still
kept control by not allowing anything to be installed except through the
iTunes App Store. Even the free Apps. If something similar was allowed
for the Mac, I think he would see the popularity of the Mac increase also.
I just can't validate paying twice the price for software just because it's a
Mac. It's good, but not that good.

For Christmas I was given an iPad by my wife
and kids. Now, you want to talk about what I think is the best
invention of the 21st century. Since December, I use my PCs at
least 50% less. My iPad sits next to me on the couch when it is
not in my hand. Email, Messenger and text messaging is with
me now wherever I am, between the iPad and iPhone. The two
are very similar, but the 9" screen on the iPad is much easier to 
read and work with.

The iPad comes with several built-in Apps, such as Calendar (to
track your appointments), Notes (to keep lists of things), Maps
(complete Google maps), Videos (to watch your favorite videos), YouTube, iTunes, App
Store and Games. They also include Safari (Apple's Internet browser), Email, Photos
(access to your photos, graphics and screen captures), iPod (for music) and Contacts.
That's plenty to keep you going until you learn how to start downloading some of the
thousands of Apps available, with more coming every day. If you're into anything, there is
probably an App for it. Also, there are free Internet music-streaming sites that will allow you
to listen to any kind of music whenever you want, with no hiccups.

The battery is excellent. With my constant use, I still get two to three days between charges,
and the recharge is very fast.

Apple has also released iBooks, which will probably be a permanent fixture in the next iOS
upgrade. In my opinion, it's one of the better (free) eBooks reader programs. If you're used
to using Kindle, Google or any of the other readers, there is an App out there for that, too. I
downloaded a free App the other day that makes 23,469 classic books available at your tap.
And I did say free.

One App I especially like is the Dragon Speaking App, for both the
iPhone and the iPad. There is no need to type. Just start the App,
push Record and start talking. It recognizes when you stop, allows
you to insert commas, periods and new paragraphs. When you're
done with the dictation, tap Copy, then paste it wherever you want,
or tap Email and it will send it directly into your email. Oh yeah, did I
mention it was free?!

The iPad does not come with a text program, like the iPhone, but there are several free
Apps that will take care of this problem. I use one that I am more than happy to pay for but
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see no reason to do so as the developers do not ask me to. There is a small nonintrusive
ad area in the lower left corner and that's it. The same with Messenger. 

I am currently using Dragon Speaking with a free App called Documents to create this
article. Documents allows you to review and edit Word and Excel documents. I wouldn't
expect to be able to work on some gigantic files. I expect a version of Word and Excel to 
be out soon, assuming Apple will allow a Microsoft App to infiltrate their domain.

Another thing I am really pleased with are Apps available for our younger computer users.
My daughter and son-in-law both have iPads, so my 5-year-old granddaughter is
well-versed on using the iPad. I typically get her to teach me some secret thing when she
comes over on the weekends. I spent a lot of money for the overhead movie system in my
Tahoe for her to be able to watch movies, etc., when we are in the car. Lately, though, she
would rather have my iPad while we are driving around. There are some excellent
educational Apps (free, of course) that help teach her to read, do math, draw and all sorts of
other things.

In any case, as I have thanked
Bill Gates and the team at
Microsoft in the past for making
computing enjoyable with
Windows, I now need to thank
Steve Jobs and the gang at
Apple for heading in a new
direction and once again making
computing enjoyable. I can't wait
for the 22nd century to get here!

Sent from Larry's iPad.  

That’s all.....
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